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Overview

This chapter covers the following topics:

e OVPI and system resources

e New features in version 4.1

e Folders and reports

e Integration with HP OpenView Operations (OVO)
e  Ways to customize reports

e Sources for additional information

OVPI and System Resources

HP OpenView Performance Insight (OVPI) is a performance management and reporting
application. Long-term data collection, in-depth analysis, and interactive web-based reporting
are this application’s primary strengths. If desired, you can integrate OVPI with network
management or system management applications, including NNM and OVO. Integration
enhances fault isolation, problem diagnosis, and capacity planning.

The System Resource Report Pack installs on OVPI. The reports in System Resource provide
the information you need to anticipate resource issues before they become serious. You will
know whether resources are plentiful, limited, or somewhere in between, you will be able to
compare yesterday’s utilization to weekly and monthly trends, and for a system that is seeing
higher utilization, you will know when a performance threshold will be reached.

Our approach to system resource performance management uses a main package, multiple
sub-packages, and multiple datapipes. The main package and the sub-packages do not use the
same datapipe. There are actually three datapipes for the main package—one that discovers
OpenView agents, one that polls OpenView agents, and one that collects data from any system
that supports the Host Resources MIB. Each sub-package has its own built-in datapipe. For
more information about datapipes, see Chapter 2, Data Collection.

New Features in Version 4.1

System Resource 4.1 is one of three enhanced report packs released in June 2005. The other
two enhanced report packs are Device Resource 3.1 and Interface Reporting 5.0. Enhanced
report packs incorporate the following improvements:

¢ Report linking
e Launch Point page

e Ad hoc selector reports



¢ Color-coded graphics in selection tables
¢ One-step upgrade packages

The links in reports allow you to move immediately from one report to another without having
to close the report you are viewing, return to a report directory, and then open another report
in the directory. Navigating reports is now more like navigating a website—numerous links
are available and investigating a specific area of interest is easier and more efficient. In
addition to moving from one report to another report within the same report pack, you can
also link to reports in a different report pack. For example, from a report in System Resource
you can link to a report in Interface Reporting.

The Launch Point page provides an overview of package contents by grouping reports into
logical categories, for example, Near Real Time reports, forecasting reports, and ad hoc
selector reports. The ad hoc selector option opens an abbreviated report that lets you select
specific elements from a set of drop-down menus. The drop-down menus make it easy to
pin-point an item of interest. In addition, response time is especially good. Since this report
launches just a few queries against the database, you won’t be waiting for data to appear.

System Resource 4.1 has new upgrade packages. The new upgrade packages eliminate the
need for a version-by-version upgrade that entails starting and stopping Package Manager
multiple times. Instead, now you can upgrade an existing package to the latest version by
installing a single upgrade package. Note also that the main package and the sub-packages
have matching version numbers. The main package is 4.1 and all four sub-packages are 4.1.

The following table describes recent enhancements to System Resource.

Version Release Date Features/Enhancements

3.0 May 2003 OVPI Object Manager support
new change forms:

e Update System

e Update Filesystem

new datapipe:

e SysRes OVPA Datapipe 1.0

3.0 October 2003 new datapipe:
SysRes OVPA Datapipe 2.0

4.0 April 2004 Oracle support

new reports:

¢ CPU Resource Utilization Forecast

e CPU Performance QuickView

e Disk Details QuickView

¢ Logical Volume Details QuickView

¢ Network Interface Details QuickView
¢ Process Details QuickView

¢ Top Ten Transactions

e Transactions per System Snapshot

e System Availability (downtime/uptime)
e System Inventory

¢ Systems Performing Each Application/Snapshot
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Version

Release Date

Features/Enhancements

4.0

April 2004

changes to existing reports:

1. SLM—Executive Summary Report

e (Customer selection table: added Total Exceptions

¢ Location table: removed Total Vol + Avg Daily Volume
e Total Exceptions graph: added daily and monthly tabs

Total Exceptions graph: removed references to volume
. System Volume and CPU Utilization Top Ten Report
Highest CPU table: added Queue Length
Highest Volume table: added Total Network Util
. Memory Resource Optimization Report

[\]

w

Overutilized Sys Memory table: added Avg Page Outs
4. CPU Forecast Report
DTT selection table: added 30 and 60 day forecast
. Memory Forecast Report
DTT selection table: added 30 and 60 day forecast
6. Filesystem Forecast Report
DTT selection table: added 30 and 60 day forecast

(9}

4.0

August 2004

new upgrade packages:

e UPGRADE_SR_3.0_to_4.0.ap

e UPGRADE_SR_CPU_1.0_to_1.5.ap

e UPGRADE_SR_DISK_1.0_to_1.5.ap
e UPGRADE_SR_PROC_1.0_to_1.5.ap
e UPGRADE_SR_NetIf_1.0_to_1.5.ap
e UPGRADE_SR_LV_1.0_to_1.5.ap

4.0

November 2004

new datapipes:
e SysRes OVPA Collection Datapipe 1.0
e SysRes OVPA Datapipe 2.6

4.1

June 2005

Report linking

Launch Point page

Ad hoc selector reports
Color-coded graphics in selection tables
new upgrade packages:

e UPGRADE_SR to_4.1

e UPGRADE_SR_CPU_to_4.1

e UPGRADE_SR_DISK to_4.1
e UPGRADE_SR_PROC_to_4.1
e UPGRADE_SR_NetIf to_4.1
e UPGRADE_SR_LV_to_4.1
new datapipe:

e SysRes OVPA Datapipe 2.8

4.1

December 2005

No changes

Overview



10

Folders and Reports

Following is an alphabetical list of reports in the main package:

1 CPU Utilization Resource Forecast

Filesystem Utilization Resource Forecast

Filesystem Resource Optimization

Memory Utilization Resource Forecast

Memory Resource Optimization

System CPU, Memory, and Swap Utilization Exception Hot Spots
System CPU, Memory, and Swap Utilization QuickView

System CPU, Memory, and Swap Utilization QuickView - Snapshot

O 00 N 00 O A W N

System CPU, Memory, and Swap Utilization QuickView - Near Real Time

—_
o

System CPU, Memory, and Swap Utilization QuickView - Near Real Time - Snapshot

—_
—_

Service Level Management Executive Summary

—_
N

System Availability

—_
w

System Inventory

N

Systems Performing Each Application — Snapshot
15 System Volume and CPU Utilization Top Ten
16 Top Ten Transaction

17 Transactions per System — Snapshot

Generic Reports

System Resource 4.1 includes the following generic report types:
e Top Ten

e Hot Spots

¢  QuickView

e Near Real Time

e Executive Summary

¢ Forecast

If you want to find out where volume and utilization are the heaviest, open the Top Ten
report. This report sorts systems by volume (highest to lowest), by CPU utilization (highest to
lowest), and by filesystem utilization (highest to lowest), allowing you to see which systems, if
any, are experiencing unusual activity.

If you see a system in the Top Ten report that needs further investigation, open the Snapshot
version of the QuickView and select the system or systems that interest you. This report
provides utilization averages for yesterday, shows you what the exception thresholds are, and
provides graphs that track utilization levels on an hourly basis.
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If you want to see recent performance data that has not been aggregated into hourly averages,
open the Near Real Time version of the QuickView. By looking at actual sample data
collected over the previous six hours, you can find out whether a bad condition is improving or
worsening. If the QuickView is showing over-utilization, use the Optimization reports to see
whether simple load balancing might be the easiest way to improve service quality.

If you suspect that utilization levels are high and getting worse, use the Forecast reports to
pinpoint systems that may be headed toward high utilization. Forecast reports provide the
following details:

¢ Days to Threshold (DTT)
e KEstimated utilization 30, 60, and 90 days from today
e Grade of Service scores for the previous 24 hours

e CPU, memory, swap, and filesystem utilization trends over the previous 24 hours

Integration with OVO

You can isolate faults and diagnose problems faster by integrating System Resource with HP
OpenView Operations (OVO). To do that, install the thresholds sub-package that comes with
System Resource. The thresholds sub-package contains a thresholds policy used by the
Thresholds Module to monitor the database for threshold breaches. When the Thresholds
Module detects a breach, it takes one of several possible actions. The default action is to send
a breach trap to Network Node Manager (NNM). When the condition clears, the default action
is to send a clear trap to NNM.

Because NNM is the default destination for traps, you must configure the Thresholds Module
to send traps to OVO. You will make this change by opening the SNMP Trap Action Definition
form, filling in the necessary information, and saving your changes. In addition, your OVO
administrator will have to prepare a trap template definition for OVO. The Thresholds Module
5.0 User Guide contains the information needed to prepare the template.

Ways to Customize Reports

Overview

You can customize reports by importing properties, by applying group filters, by applying
constraints, and by editing tables and graphs. Service providers use group filters to produce
customer-specific reports. Any user can apply a constraint to report, and any user can edit
tables and graphs. For details about editing tables and graphs (selecting view options), see
Appendix A, Editing Tables and Graphs.

Group Filters

You can share reports with customers by configuring OVPI to generate customer-specific
reports. You configure OVPI to generate customer-specific report by creating and applying
group filters. Creating group filters involves the following tasks:

e Importing custom property information (customers, locations, IP addresses for nodes, and
host names for nodes) using Common Property Tables

¢ C(Creating a group account for all of the users affiliated with a particular customer

e Creating a group filter for the group account

11



For more information about group filters, refer to the OVPI 5.1 Administration Guide.

Applying Constraints

When you edit a parameter, you apply a constraint. The constraint removes data you are not
interested in seeing. If you edit the Customer_Name parameter, data for every customer
except the customer you typed in the Customer_Name field will drop from the report. If you
edit the Location_Name parameter, data for all locations except the location you typed in the
Location_Name field will drop from the report.

You can apply multiple constraints at the same time. System Resource supports the following
parameters:

e (Customer Name
e Location_ Name
e Device

If you are using the Web Access Server to view reports, apply a constraint by clicking the Edit
Parameters icon at the bottom right-hand corner of the report. When the Edit Parameters
window opens, enter the constraint in the field and click Submit.

If you are using the Report Viewer application, apply a constraint by selecting Edit > Parameter
Values from the menu bar. When the Modify Parameter Values window opens, click Current
Value. Enter a new value and click OK.

Adding Customized Property Data

The reports in System Resource 4.1 can be populated with the following properties:
e [P address for the device

e Host name for the device

e Name of the customer associated with the device

e Location associated with the device

When this information appears in a report, the report is reading database tables maintained
by the Common Property Tables package. If you are about to install Common Property Tables
for the first time, you can import properties by using the batch-mode property import utility
that comes with Common Property Tables. Once you import properties in batch mode, you
have two ways to modify existing properties:

e  Use the batch-mode property import utility (edit a file, then import the edited file)
e Use the change forms that come with Common Property Tables

For details about both approaches, refer to the Common Property Tables 3.5 User Guide.

Sources for Additional Information

This user guide includes samples of some of the reports in System Resource. The demo package
that comes with System Resource contains a sample of every report in the package. If you have
access to the demo package and you want to know what fully-populated reports look like, install
the demo package. Like real reports, demo reports are interactive; unlike real reports, demo
reports are static.
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Overview

The following documents are related to this manual:

System Resource Report Pack 4.1 Release Statement
Understanding the SysRes OVPA Datapipe, May 2005
SysRes OVPA Datapipe 2.8 Release Statement

SysRes OVPA Collection Datapipe 1.0 Release Statement
SysRes RFC1514 Datapipe 4.0 Release Statement

Metrics for HP OV Performance Agent and Operations Agent
OVPI Report Packs, Version 8.0: Release Notes, June 2005

The document about OVPA and EPC metrics, as well as the other documents listed above,
can be downloaded from this site:

http:/www.managementsoftware.hp.com

Select Support > Product Manuals to reach the Product Manuals Search page. The user guides for
OVPI are listed under Performance Insight. The user guides for report packs and datapipes are
listed under Performance Insight Reporting Solutions.

The manuals listed under Performance Insight Reporting Solutions indicate the month and year
of publication. If a manual is revised and reposted, the date of publication will change. Since
we post revised manuals on a regular basis, we recommend searching this site for updates
before using an older manual that might not be the latest version available.
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2 Data Collection

This chapter covers the following topics:

e SysRes RFC 1514 Datapipe 4.0

e SysRes OVPA Collection Datapipe 1.0

e SysRes OVPA Datapipe 2.8

e Collections performed by the sub-packages

SysRes RFC 1514 Datapipe

The SysRes RFC 1514 Datapipe collects the following data from the Host Resources MIB:
e CPU utilization

e Memory utilization

e Number of page outs

¢ Run queue length

e Swap utilization

SysRes OVPA Collection Datapipe

The SysRes OVPA Collection Datapipe performs the following tasks:
e Discovers OVPA or EPC performance agents

¢ Inserts pa_collect statements into the trendtimer.sched file

e Populates the OVPA type group for use in the collection process

The discovery process runs once a day. In accordance with directives in the
OVPA_Collection_Daily.pro file, the discovery process attempts to check all of the nodes in
ksi_managed_node table. Since SNMP discovery can only discover SNMP-pollable devices,
you may want to add OVPA or EPC systems using the create node tool.

Once the discovery process starts, it writes to the pa_discovery.data file in the DPIPE_HOME/
data directory. The pa_discovery.data file contains the systems the discovery process finds.
Once the discovery process is complete, ee_collect loads the pa_discovery.data file into OVPI.
The data is placed in the K_padatasources table.
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SysRes OVPA Datapipe

The SysRes OVPA Datapipe collects metrics from the following classes:
e Global

¢ Filesystem

e Application

¢ Transaction

¢ Configuration

Metrics in the configuration class are collected once daily. The other classes are collected
hourly. The metrics collected for System Resource by the SysRes OVPA Datapipe come from
two agents:

e HP OpenView Performance Agent (OVPA)
¢ Embedded Performance Component of OpenView Operations (OVOA)

OVOA, also known as EPC, ships with OVOU 7.0 and OVOW 7.0. If you are using OVOU 7.0
(or later) or OVOW 7.0 (or later), the SysRes OVPA Datapipe collects metrics from EPC. If you
are using an earlier version of OVO, the SysRes OVPA Datapipe collect metrics from OVPA.

The metrics gathered by OVPA are different from the metrics gathered by EPC. For details
about how the metrics vary, refer to Metrics for HP OV Performance Agent and Operations
Agent. You can download this document from the Product Manuals website. Look for it in one
of two places, under Operations for Windows and under Operations for UNIX.

For more information about the SysRes OVPA Datapipe, including information about tables,
metrics, and mapping, refer to Understanding the OVPA Datapipe.

Collections Performed by Sub-Packages

The following sub-packages can be installed with the System Resource Report Pack:

e CPU
e  Process
e Disk

e Logical Volume
e Network Interface

Each sub-package provides a built-in data collection. Each collection takes place hourly. In
addition, each collection is a history-styled collection. When the system is polled, the datapipe
returns multiple rows, with each row having a distinct ta_period. The first time the collection
runs, all rows from midnight of the previous day will be returned. Each collection thereafter
will only return data that has not already been collected.

Limiting subsequent collections to data that has not already been collected is accomplished
using history property tables. These tables contain the last ta_sysuptime value in the lastPoll
column. Each collection after the first collection asks for data with a time stamp value greater
than the value in lastPoll.
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CPU Sub-Package

The CPU sub-package collects data from the CPU class. All systems in the OVPA type group
will be collected for the CPU collection.

Data Table Matrix

Table/File Name

Raw Table xSR_OVPA_CPU

Rate Table RSR_OVPA_CPU

Property Table K OVPA_CPU

Teel File SysResOVPA_CPU.teel
Property Table Matrix

Table/File Name

Property Table K OVPA_CPU

Teel File prop_OVPA_CPU.teel

History Property Table Matrix

Table/File Name

Property Table K _OVPA_CPU_History
History Property Table K_OVPA_CPU_History
History Teel File prop_OVPA_CPU_history.teel

Collected CPU Metrics

Data Collection

The collection table is RSR_OVPA_CPU. Supported metrics vary from platform to platform
and from OVPA to EPC agents.

Metric

Description

BYCPU_ID

CPUID

BYCPU_CPU_SYS_MODE_UTIL The percent of time CPU was in System Mode.

BYCPU_CPU_USER_MODE_UTIL | The percent of time CPU was in User Mode.

BYCPU_CPU_TOTAL_UTIL The percent CPU utilization.
BYCPU_STATE CPU State
BYCPU_INTERRUPT RATE Average number of device interrupts.

BYCPU_CSWITCH_RATE

Context switch rate

17



Daily Processing

The SR_Daily_CPU.pro file is invoked at 2:00 every morning. The daily processing consists of

running the SD_SR_CPU.sum file.

Hourly Processing

The SR_Hourly_CPU.pro file is invoked every hour.

The hourly processing handles new systems, updates the CPU property table, and data
mapping from the datapipe rate table to the System Resource CPU Report Pack base table.

When new systems are found they need to be added to K_Node before the summaries take
place. This is done using the stored procedure ppSR_OVPACPU_SetIDs. The stored procedure
is invoked using the SQL script execute_SR_OVPACPU_SetIDs.sql. The stored procedure
populates K_Node with the new system and populates the node_fk column in the datapipe

property table with the dsi_key_id value for that system from K_Node.

The CPU update populates the K_System_CPU property table with the CPU state.

Mapping RSR_OVPA_CPU to SH_SR_CPU

Purpose: Map system metrics from RSR_OVPA_CPU to the System Resource CPU base table

SH_SR_CPU.

File: SH_SR_CPU.sum

source table: RSR_OVPA_CPU
destination table: SH_SR_CPU
by variable: node_fk

by variable: CPUid

by variable: hour

column: CPUSystemMode=BYCPU_CPU_SYS_MODE_UTIL:avg
column: CPUUserMode=BYCPU_CPU_USER_MODE_UTIL:avg
column: CPUUtil=BYCPU_CPU_TOTAL_UTIL:avg

column: CSRate=BYCPU_CSWITCH_RATE:avg

column: IntRate=BYCPU_INTERRUPT_RATE:avg

Source Metric Destination Metric | Summary Type
BYCPU_CPU_SYS_MODE_UTIL AVGCPUSystemMode | avg
BYCPU_CPU_USER_MODE_UTIL AVGCPUUserMode avg
BYCPU_CPU_TOTAL_UTIL AVGCPUUtil avg
BYCPU_CSWITCH_RATE AVGCSRate avg
BYCPU_INTERRUPT_RATE AVGIntRate avg

Logical Volume Sub-Package

The Logical Volume sub-package collects data from the Logical Volume class. All systems in

the OVPA type group will be collected for the Logical Volume collection.

18
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Data Table Matrix

Table/File Name

Raw Table xSR_OVPA_LV

Rate Table RSR_OVPA_LV

Property Table K_OVPA_LogicalVolue

Teel File SysResOVPA_LogicalVolume.teel
Property Table Matrix

Table/File Name

Property Table K_OVPA_LogicalVolume

Teel File prop_OVPA_LogicalVolume.teel

History Property Table Matrix

Table/File Name

Property Table K_OVPA_LV_History

History Property Table K _OVPA_LV_History

History Teel File prop_SysResOVPA_LV_history.teel

Collected Logical Volume Metrics

The collection table is RSR_OVPA_LogicalVolume. Supported metrics vary from platform to

platform and are supported on the OVPA agent only.
Metric Description
LV_DIRNAME The absolute path name of Logical volume on HP OS.

LV_READ_RATE

Number of physical reads per second for this logical
volume during the interval.

LV_WRITE_RATE

Number of physical writes per second for this logical
volume during the interval.

LV_SPACE_UTIL

Percent of the logical volume file system space in use
during the interval.

Daily Processing

The SR_Daily_LogicalVolume.pro file is invoked at 2:00 every morning. The daily processing
consists of running the SD_SR_LogicalVolume.sum file.

Data Collection
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Hourly Processing

The SR_Hourly_LogicalVolume.pro file is invoked every hour.

The hourly processing handles new systems and data mapping from the datapipe rate table to
the System Resource Logical Volume Report Pack base table.

When new systems are found, they need to be added to K_Node before the summaries take
place. This is done using the stored procedure ppSR_OVPALogicalVolume_SetIDs. The stored
procedure is invoked using the SQL script execute_SR_OVPALogicalVolume_SetIDs.sql. The
stored procedure populates K_Node with the new system and populates the node_fk column in
the datapipe property table with the dsi_key_id value for that system from K_Node.

Mapping RSR_OVPA _LogicalVolume to SH_SR_LogicalVolume

Purpose: Map metrics from RSR_OVPA_LogicalVolume to the LogicalVolume base table

SH_SR_LogicalVolume.

File: SH_SR_LogicalVolume.sum

source table: RSRV_OVPA_LogicalVolume
destination table: SH_SR_LogicalVolume
by variable: node_fk

by variable: LV_DIRNAME

by variable: hour

Source Metric

Destination Metric

Summary Type

LV_READ_RATE AVGReadRate avg
LV_WRITE_RATE AVGWriteRate avg
LV_SPACE_UTIL AVGSpaceUtil avg

Network Interface Sub-Package

The Network Interface sub-package collects data from the Network Interface class. All
systems in the OVPA type group will be collected for the Network Interface collection.

Data Table Matrix
Table/File Name
Raw Table xSR_OVPA_NetIf
Rate Table RSR_OVPA_NetIf
Property Table K OVPA_NetlInterface
Teel File SysResOVPA_NetInterface.teel
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Property Table Matrix

Table/File Name
Property Table K OVPA_NetlInterface
Teel File prop_OVPA_NetInterface.teel

History Property Table Matrix

Table/File Name

Property Table K_OVPA_NetInterface_History
History Property Table K _OVPA_NETIF_History

History Teel File prop_SysResOVPA_NetIf history.teel

Collected Network Interface Metrics

The collection table is RSR_OVPA_NetIf. Supported metrics vary from platform to platform
and from OVPA to EPC agents.

Metric Description
BYNETIF_COLLISION_RATE The name of the network interface.
BYNETIF_IN PACKET RATE The number of physical collisions per second on

the network interface during the interval.

BYNETIF_OUT_PACKET_RATE The number of successful physical packets per

second received through the network interface
during the interval.

BYNETIF_IN_BYTE_RATE The number of successful physical packets per

second sent through the network interface during
the interval.

BYNETIF _OUT BYTE RATE The number of KBs per second received to the

network via this interface during the interval.

BYNETIF_ERROR_RATE

Number of KBs per second sent to the network
via this interface during the interval.

BYNETIF_NET_SPEED

Number of physical errors per second on the
network interface during the interval.

BYNETIF_COLLISION_RATE The speed of this interface.

Daily Processing

The SR_Daily_NetInterface.pro file is invoked at 2:00 every morning. The daily processing
consists of running the SD_SR_NetInterface.sum file.

Data Collection
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Hourly Processing

The SR_Hourly_NetInterface.pro file is invoked every hour.

The hourly processing handles new systems and data mapping from the datapipe rate table to
the System Resource Network Interface Report Pack base table.

When new systems are found, they need to be added to K_Node before the summaries take

place. This is done using the stored procedure ppSR_OVPANetIf SetIDs. The stored

procedure is invoked using the SQL script execute_SR_OVPANetIf SetIDs.sql. The stored
procedure populates K_Node with the new system and populates the node_fk column in the

datapipe property table with the dsi_key_id value for that system from K_Node.

Mapping RSR_OVPA_Netlf to SH_SR_NetInterface

Purpose: Map system metrics from RSR_OVPA_NetIf to the Network Interface base table

SH_SR_NetInterface.

File: SH_SR_NetInterface.sum

source table: RSR_OVPA_NetIf
destination table: SH_SR_NetInterface
by variable: node_fk

by variable: prop_netif name

by variable: hour

column: CollisionRate=BYNETIF_COLLISION_RATE:avg
column: InPackets=BYNETIF_IN_PACKET RATE:avg
column: OutPackets=BYNETIF_OUT_PACKET_RATE:avg
column: InBytes=BYNETIF_IN_BYTE_RATE:avg

column: OutBytes=BYNETIF_OUT_BYTE_RATE:avg
column: ErrorRate=BYNETIF_ERROR_RATE:avg

column: NetSpeed=BYNETIF_NET_SPEED:avg

Source Metric Destination Metric | Summary Type
BYNETIF_COLLISION_RATE AVGCollisionRate avg
BYNETIF_IN_PACKET_RATE AVGInPackets avg
BYNETIF _OUT PACKET RATE AVGOutPackets avg
BYNETIF_IN_BYTE_RATE AVGInBytes avg
BYNETIF_OUT_BYTE_RATE AVGOutBytes avg
BYNETIF_ERROR_RATE AVGErrorRate avg
BYNETIF_NET_SPEED AVGNetSpeed avg

Disk Sub-Package

The Disk sub-package collects data from the Disk class. All systems in the OVPA type group

will be collected for the Disk collection.
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Data Table Matrix.

Table/File Name

Raw Table xSR_OVPA_Disk

Rate Table RSR_OVPA_Disk

Property Table K _OVPA_Disk

Teel File SysResOVPA_Disk.teel
Property Table Matrix

Table/File Name

Property Table K OVPA_Disk

Teel File prop_OVPA_Disk.teel

History Property Table Matrix

Table/File Name

Property Table K OVPA_Disk

History Property Table K _OVPA_DISK_History

History Teel File prop_SysResOVPA_Disk_history.teel

Collected Disk Metrics

Data Collection

Metric

Description

BYDSK_DEVNAME

Name identifying the specific disk.

BYDSK_DIRNAME

Name of the file system directory mounted on this
disk device. Displays Multiple F'S if more than
one exists.

BYDSK_AVG_SERVICE_TIME

Average time, in milliseconds, that this disk spent
in processing each disk request during the
interval

BYDSK _PHYS_IO_RATE

Average number of physical IO requests per
second for this disk device during the interval.

BYDSK UTIL

Utilization, or percent of the time busy servicing
requests for this device.

BYDSK_FS_READ_RATE

Number of physical file system reads per second
from this disk device during the interval.

The collection table is RSR_OVPA_Disk. Supported metrics vary from platform to platform
and from OVPA to EPC agents.
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Metric

Description

BYDSK_FS_WRITE_RATE

Number of physical file system writes per second
from this disk device during the interval.

BYDSK VM_IO_RATE

Number of virtual memory IOs per second to this
disk device during the interval.

BYDSK_RAW_READ_RATE

Number of raw reads per second from this disk
device during the interval.

BYDSK_RAW_WRITE_RATE

Number of raw writes per second to this disk
device during the interval.

BYDSK SYSTEM_IO_RATE

Number of physical system reads or writes per
second to this disk device during the interval.

Daily Processing

The SR_Daily_Disk.pro file is invoked at 2:00 every morning. The daily processing consists of
running the SD_SR_Disk.sum file.

Hourly Processing

The SR_Hourly_Disk.pro file is invoked every hour. Hourly processing handles new systems

and data mapping from the datapipe rate table to the Disk Sub-Package base table.

When new systems are found, they need to be added to K_Node before the summaries take

place. This is done using the stored procedure ppSR_OVPADisk_SetIDs. The stored procedure

is invoked using the SQL script execute_SR_OVPADisk_SetIDs.sql. The stored procedure
populates K_Node with the new system and populates the node_fk column in the datapipe
property table with the dsi_key_id value for that system from K_Node.
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Mapping RSR_OVPA _Disk to SH_SR_Disk

Purpose: Map metrics from RSR_OVPA_Disk to the SH_SR_Disk base table.

File: SH_SR_Disk.sum

source table: RSR_OVPA_Disk
destination table: SH_SR_Disk
by variable: node_fk

by variable: prop_disk_name

by variable: hour

column:
column:
column:
column:
column:
column:
column:
column:

ServiceTime=BYDSK_AVG_SERVICE_TIME:avg
DiskUtil=BYDSK_UTIL:avg
PhysicallORate=BYDSK_PHYS_I0_RATE:avg
FSReadRate=BYDSK_FS_READ_RATE:avg
FSWriteRate=BYDSK_FS_WRITE_RATE:avg
RawReadRate=BYDSK_RAW_READ_RATE:avg
RawWriteRate=BYDSK_RAW_WRITE_RATE:avg
¢=BYDSK_VM_IO_RATE:avg

column: SystemIORate=BYDSK_SYSTEM_IO_RATE:avg

Source Metric Destination Metric | Summary Type
BYDSK AVG_SERVICE_TIME AVGServiceTime avg
BYDSK_UTIL AVGDiskUtil avg
BYDSK_PHYS_IO_RATE AVGPhysicallORate |avg
BYDSK FS_READ_RATE AVGFSReadRate avg
BYDSK_FS_WRITE_RATE AVG FSWriteRate avg
BYDSK_RAW_READ_RATE AVGRawReadRate avg
BYDSK RAW _WRITE_RATE AVGRawWriteRate avg
BYDSK _VM_IO_RATE AVGVMIORate avg
BYDSK_SYSTEM_IO_RATE AVGSystemIORate avg

Process Sub-Package

Data Collection

The Process sub-package performs an hourly collection. The Process collection collects all

systems in the OVPA type group.

25




26

Data Table Matrix.

Table/File Name

Raw Table xSR_OVPA_process

Rate Table RSR_OVPA _process

Property Table K _ProcOVPA_proc

Teel File SysResOVPA_Process.teel
Property Table Matrix

Table/File Name

Property Table K_ProcOVPA_proc

Teel File prop_ProcOVPA_proc.teel

History Property Table Matrix

Table/File Name

Property Table K_OVPA_proc

History Property Table K OVPA_PROC_HISTORY
History Teel File prop_ProcOVPA_proc_history.teel

Collected Process Metrics

The collection table is RSR_OVPA_process. Supported metrics vary from platform to platform
and are only supported by the OVPA agent.

Metric

Description

PROC_CPU_TOTAL_TIME | Total CPU Time consumed in seconds.

PROC_PROC_NAME

Process name.

PROC_CPU_TOTAL_UTIL

Percentage of CPU Time Consumed.

PROC_THREAD_COUNT

Total number of threads.

PROC_MEM_VIRT

Sum of virtual memory used.

Daily Processing

The SR_Daily_Process.pro file is invoked at 2:00 every morning. The daily processing consists
of running the SD_SR_proc.sum file.

Hourly Processing

The SR_Hourly_Process.pro file is invoked every hour.
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The hourly processing handles new systems and data mapping from the datapipe rate table to

the System Resource Disk Report Pack base table.

When new systems are found, they need to be added to K_Node before the summaries take
place. This is done using the stored procedure ppSR_OVPAProc_SetIDs. The stored procedure
is invoked using the SQL script execute_SR_OVPAProc_SetIDs.sql. The stored procedure
populates K_Node with the new system and populates the node_fk column in the datapipe

property table with the dsi_key_id value for that system from K_Node.

Mapping RSR_OVPA _process to SH_SR_Process

Data Collection

Purpose: Maps metrics from RSR_OVPA_process to the SH_SR_Process base table.

File: SH_SR_proc.sum

source table: xSR_OVPA_process
destination table: SH_SR_Process
by variable: node_fk

by variable: Process_Name

by variable: hour

column: CPUTime=PROC_CPU_TOTAL_TIME:tot
column: CPUUtil=PROC_CPU_TOTAL_UTIL:avg
column: ThreadCount=PROC_THREAD_COUNT:tot
column: VirtualMem=PROC_MEM_VIRT:tot

Source Metric Destination Metric | Summary Type
PROC_CPU_TOTAL_TIME TOTCPUTime tot
PROC_CPU_TOTAL_UTIL AVGCPUUtil avg
PROC_THREAD_COUNT TOTThreadCount tot
PROC_MEM_VIRT TOTVirtualMem tot
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3 The Upgrade Install

This chapter covers the following topics:
¢  Guidelines for a smooth upgrade

e Installing System Resource 4.1

e Post-installation steps

¢ Uninstalling System Resource 4.1

Guidelines for a Smooth Install

The December 2005 report pack CD contains the latest report packs and datapipes. When you
insert the report pack CD in the CD-ROM drive and launch the package extraction program,
the install script extracts every package from the CD and copies the results to the Packages
directory on your system. After the extract finishes, the install script prompts you to start
Package Manager. Before using Package Manager, become familiar with the following topics:

e Software prerequisites for System Resource
e Datapipes and remote pollers

e Deleting custom table view

Software Prerequisites

System Resource 4.1 has the following prerequisites:
e OVPI5.1

e Any service packs available for OVPI 5.1

e Common Property Tables 3.5

If you are running an earlier version of Common Property Tables, upgrade to Common
Property Tables 3.5 by installing the “to_3.5” upgrade package. Upgrade Common Property
Tables before upgrading the System Resource Report Pack.

Datapipes and Remote Pollers

Datapipes cannot be upgraded. You must remove the existing datapipe, then re-install the
latest version of the datapipe after the upgrade is complete. When you uninstall an existing
datapipe, the following information will be lost:

¢ The polling policy for a single remote poller

¢ (Cloned polling policies for multiple remote pollers
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¢ Polling groups you created yourself

To export existing polling policy configurations and customized polling group, use the
collection_manager and group_manager commands.

Exporting Polling Policy Configurations
If your environment contains polling policies for remote pollers, use the collection_manager
command to export exiting policy configurations to a file.
UNIX: As user trendadm, run the following command:
cd $DPIPE_HOME
./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install
directory and execute the following command:

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Customized Polling Groups
If your environment contains customized polling groups, use the group_manager command to
export groups to individual .xml files.
UNIX: As user trendadm, execute the following command:
cd $DPIPE_HOME
./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install
directory and execute the following command:

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created custom table views, the views you created may interfere with the report pack
upgrade process, causing the upgrade to fail. Whether or not your custom table views
interfere with the upgrade depends on how you created them. If you created them using SQL,
the upgrade will succeed but your custom views will not be available once the upgrade is
complete. If you created them using Datapipe Manager, the upgrade is likely to fail. To
prevent the upgrade from failing, delete your custom table views before upgrading the report
pack, then recreate these views after the upgrade is complete.

Upgrading to Version 4.1

Follow these steps to upgrade the System Resource Report Pack. Since your existing
datapipes cannot be upgraded, they must be uninstalled before you upgrade the report pack,
then reinstalled after the report pack is upgraded.

1 Login to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to stop running.
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The Upgrade Install

Windows NT:
a Select Control Panel > Administrative Tools > Services
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
UNIX: As root, do one of the following:
— HP-UX: sh /sbin/ovpi_timer stop
— Sun: sh /etc/init.d/ovpi_timer stop

If necessary, upgrade Common Property Tables by installing the “to_3.5” upgrade
package.

Uninstall the datapipes you installed when you installed your current version of System
Resource.

’ The SysRes RFC 1514 Datapipe has not changed since System Resource 4.0 was
released. If this is the only datapipe you are using, there is no need to uninstall it
before upgrading the report pack.

’ If you are running OVPI on UNIX and using Sybase for database management,
you have an extra step to perform but only if you are uninstalling version 1.0 of the
SysRes OVPA Datapipe and upgrading to version 2.8. After uninstalling version
1.0, you must remove several .bcpg files manually.

e Navigate to: {COLLECT HOME}/collect/SR/
¢ Remove the following files:
— xSR _OVPA config.bcpg
— xSR OVPA filesystem.bcpg
— xSR_OVPA global.bcpg
Install this package: UPGRADE_System_Resource_to_4.1
Upgrade existing sub-packages; install one or more of the following sub-packages:
e UPGRADE_SR_CPU_to_4.1
e UPGRADE_SR_DISK to_4.1
e UPGRADE_SR_PROC_to_4.1
e UPGRADE_SR_Netlf to_4.1
e UPGRADE_SR_LV_to 4.1
Install datapipes:
— SysRes OVPA Datapipe 2.8 and SysRes OVPA Collection Datapipe 1.0
or
— SysRes RFC 1514 Datapipe 4.0
Restart OVPI Timer.
Windows NT: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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Post-Installation Steps

Reconfigure any polling policies and customized group definitions that need to be restored. Do
not re-import the configurations you exported. Because the old datapipe may be incompatible
with the new datapipe you just installed, re-importing the configurations you exported could
lead to data corruption. In addition, if you dropped any custom table views, you may recreate
those custom views now.

Package Removal

Uninstalling System Resource also uninstalls any datapipe that depends on System Resource.
Follow these steps to uninstall the System Resource Report Pack:

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to stop running.
Windows NT:
a Select Control Panel > Administrative Tools > Services
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
UNIX: As root, do one of the following:
— HP-UX: sh /sbin/ovpi_timer stop
— Sun: sh /etc/init.d/ovpi_timer stop

Launch Performance Insight and start Package Manager. The Package Manager welcome
window opens.

Follow the on-screen instructions for uninstalling packages. When the Selection Summary
window opens, select System Resource 4.1. When the uninstall process finishes, a package
removal complete message appears.

Click Done to return to the Management Console.
Restart OVPI Timer.
Windows NT: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 The New Install

This chapter covers the following topics:
¢  Guidelines for a smooth install

e Installing System Resource 4.1

e Accessing deployed reports

e Seeing performance data in reports

e Package removal

Guidelines for a Smooth Install

An OVPI reporting solution has at least two ingredients, a report pack and a datapipe. Some
reporting solutions offer multiple datapipes. When you install the datapipe, you configure
OVPI to collect a specific type of performance data at a specific interval. When you install the
report pack, you configure OVPI to summarize and aggregate the data that was collected by
the datapipe.

The December 2005 report pack CD contains the latest report packs and datapipes. When you
insert the CD in the CD-ROM drive and launch the package extraction program, the install
script extracts every package from the CD and copies the results to the Packages directory on
your system. After the extract finishes, the install script prompts you to start Package
Manager and follow the on-screen instructions. Before using Package Manager, review the
following guidelines.

Software Prerequisites

System Resource 4.1 has the following prerequisites:
e OVPI5.1

e All service packs available for OVPI 5.1

e Common Property Tables 3.5

If you are not running any version of Common Property Tables, let Package Manager install
Common Property Tables for you. If you are running an earlier version of Common Property
Tables, upgrade to the latest version by installing the “to_3.5” upgrade package. Upgrade
Common Property Tables before installing the System Resource Report Pack.

The datapipes that collect data for System Resource are not prerequisites. You may install the
datapipes when you install SR 4.1 or you may install the datapipes after you install SR 4.1.
Installing at least one datapipe is mandatory. These are your choices:

e SR OVPA Datapipe
e RFC 1514 Datapipe (host resources MIB)
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e OVPA Collection Datapipe [for agent discovery]

Thresholding and Integration with OpenView Operations (OVO)

If you want to implement thresholding for this package, install SystemResource_Thresholds,
a sub-package that comes with System Resource. The thresholds sub-package contains
customized thresholds. Installing the thresholds sub-package configures OVPI to monitor the
database for threshold conditions and respond to a breach condition by taking one of several
possible actions.

The thresholds sub-package requires the Thresholds Module. If you select the thresholds
sub-package for installation, Package Manager will select and install the Thresholds Module
for you, automatically. Because the Thresholds Module includes defaults designed for
Network Node Manager (NNM), you must configure the Thresholds Module to send breach
traps to OpenView Operations for Windows (OVOW) or OpenView Operations for UNIX
(OVOU). For details about the procedure for modifying category, severity, and destination
parameters, refer to the Thresholds Module 5.0 User Guide.

Distributed Environments

Central server software requirements are different from satellite server software
requirements. Install the following packages on the central server:

e System Resource 4.1
e Optional sub-packages (SR_CPU, SR_DISK, etc.)
e Common Property Tables 3.5
Install the following packages on each satellite server:
e System Resource 4.1
e Optional sub-packages (SR_CPU, SR_DISK, etc.)
e Common Property Tables 3.5
e Datapipes:

— SysRes OVPA Datapipe 2.8

— SysRes OVPA Collection Datapipe 1.0

or

— SysRes RFC 1514 4.0
e SystemResource_Thresholds (optional)
e Thresholds Module 5.0 (optional)
The thresholds sub-package reports exceptions on aggregated data, or hourly data, or both
aggregated data and hourly data. If you are only interested in seeing alarms on hourly data,
installing the thresholds sub-package on the central server is not necessary. If you want to set

thresholds on aggregated data, you must install the thresholds sub-package on the central
server.

When you finish installing packages, use the Add Database Wizard to set up connections with
satellite server databases. After those connections are set, configure trendcopy pull
commands and switch off higher-level aggregations at each satellite server. For details, see
Chapter 5, Setting Up a Distributed System.
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Installing System Resource 4.1

Task 1:

Task 2:

The New Install

Follow these steps to install System Resource:

Task 1: Stop OVPI Timer and extract packages from the report pack CD.
Task 2: Install System Resource, optional sub-packages, and at least one datapipe

Task 3: Restart OVPI Timer.

Stop OVPI Timer and extract packages from the report pack CD

1
2

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
Windows: Do the following:
a Select Control Panel > Administrative Tools > Services
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
UNIX: As root, do one of the following:
— HP-UX: sh /sbin/ovpi_timer stop
— Sun: sh /etc/init.d/ovpi_timer stop
Insert the December 2005 report pack CD in the CD-ROM drive.
Windows: A menu displays automatically.
UNIX:
a Mount the CD (if the CD does not mount automatically).
b Navigate to the top level directory on the CD.
¢ Run ./setup
Type 1 in the choice field and press Enter.

The install script displays a percentage complete bar. When the copy is complete, the
install script starts Package Manager. The Package Manager welcome window opens.

Install System Resource and at least one datapipe

1
2

Click Next. The Package Location window opens.

Click Install. Approve the default destination directory or browse to a different directory if
necessary.

Click Next. The Report Deployment window opens. Type your username and password for
the OVPI Application Server.

Click Next. The Package Selection window opens. Click the check box next to:
e System Resource 4.1

e SR_LV sub-package 4.1 (optional)

e SR_PROC sub-package 4.1 (optional)

e SR_Netlf sub-package 4.1 (optional)

e SR_CPU sub-package 4.1 (optional)
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e SR_DISK sub-package 4.1 (optional)

e Datapipes:
— SysRes OVPA Datapipe 2.8
— SysRes OVPA Collection Datapipe 1.0
or

— SysRes RFC1514 Datapipe 4.0

e SystemResource_Thresholds (optional)

) Installing the thresholds sub-package is optional. If you install the thresholds
sub-package, Package Manager will install Thresholds Module 5.0 for you.

) If you are not currently running any version of Common Property Tables,
Package Manager will select and install Common Property Tables 3.5 for you,
automatically.

) The demo package is optional. You can install the demo package and nothing
else, or you can install the demo package along with everything else.

5 Click Next. The Type Discovery window opens. Disable the default and click Next. The
Selection Summary window opens.

6  Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package installation complete message appears.

7  Click Done to return to the Management Console.

Task 3: Restart OVPI Timer

Windows NT: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed this report pack, you enabled the Deploy Reports option. As a result, the
reports in this package (as well as any forms that come with this package) are now deployed to
the OVPI Application Server. Once reports reside on the OVPI Application Server, you can
view them on the web or you can view them using the OVPI client applications.

The OVPI application clients are Report Viewer, Report Builder, and the Management
Console. If the client components are not installed on your system, you must use a web
broswer to view reports.

For more information about the OVPI appliation clients, refer to the OVPI 5.1 Installation
Guide. For more information about the Management Console, including how to use the Object/
Property Management view to launch reports specific to a selected object, refer to the OVPI
5.1 Administration Guide.
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Seeing Performance Data in Reports

Some reports populate with data sooner than others. The first report to populate with data is
the Near Real Time report. You will begin to see data in this report immediately after the first
data collection completes.

Any report that begins with an analysis of yesterday’s performance will need at least one full
day’s worth of data before results are viewable. You will begin to see forecast data soon, within
a few days. However, reliable forecast data will not be available until the baseline is complete,
and this will take several weeks.

Package Removal

Uninstalling System Resource removes any datapipe that depends on System Resource.
Follow these steps to uninstall System Resource from OVPI.

1 Login to the system. On UNIX systems, log in as root.
2 Stop OVPI Timer and wait for processes to stop running.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
— HP-UX: sh /sbin/ovpi_timer stop
— Sun: sh /etc/init.d/ovpi_timer stop

3 Launch Performance Insight and start Package Manager. The Package Manager welcome
window opens.

4 Follow the on-screen instructions for uninstalling packages. When the Selection Summary
window opens, select System Resource 4.1. When the uninstall process finishes, a package
removal complete message appears.

5 Click Done to return to the Management Console.
6 Restart OVPI Timer.
Windows NT: Select Settings > Control Panel > Administrative Tools > Services
UNIX: As root, type one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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5 Setting Up a Distributed System

This chapter covers the following topics:

¢ Installing System Resource on multiple servers
e Central server configuration

e Satellite server configuration

e System clocks

Installing System Resource on Multiple Servers

If you intend to run System Resource as a distributed system across multiple servers, each
server must be configured. Before configuring the servers, verify that everything is installed
where it needs to be installed. As shown in the following table, the datapipes belong on the
satellite servers, otherwise package installation is the same.

Central Server Satellite Server

System Resource 4.1 System Resource 4.1
SystemResource_Thresholds SystemResource_Thresholds
Thresholds Module 5.0 Thresholds Module 5.0
Common Property Tables 3.5 Common Property Tables 3.5

SysRes RFC1514 Datapipe 4.0
SysRes OVPA Datapipe 2.8
SysRes OVPA Collection Datapipe 1.0

Where you install the optional thresholds sub-package depends on how you want thresholding
to work. If you want to set thresholds on hourly data, install the thresholds sub-package on
satellite servers. If you want to set thresholds on aggregated data, install the thresholds
sub-package on the central server.

Central Server Configuration

Perform the following tasks:
e Set up connections between the central server and satellite server databases
e Configure trendcopy pull commands on the central server for hourly data

e Configure trendcopy pull commands on the central server for rate data (optional)
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Task 1:

Task 2:

Task 3:

Set up connections with satellite server databases

1 Select HP OpenView > Performance Insight > Management Console.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add
Database Wizard opens.

4 Click Next.

5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.

7  Click Finish when you are done.

Configure trendcopy pull commands for hourly data

1 Open this file: $SDPIPE HOME/scripts/SR_Hourly Reporting.pro

2 Uncomment the copy commands in the hourly_copy block and modify them as follows:
e Replace SATELLITE_SERVER_1_DATABASE with the satellite server name
e Replace THIS_MACHINE _DATABASE with the central server name

3 Ifthere is more than one satellite server, create and configure new hourly copy commands

for each additional machine.
4 Open this file: SystemResourceReporting Hourly.pro file.

Comment out the hourly trendsums.

Configure trendcopy pull commands for rate data (optional)

If you want to view Near Real Time reports on the central server, rate data must be available

on the central server. Follow these steps to pull rate data from satellite servers:

1 Open this file: $SDPIPE HOME/scripts/SR_Hourly Reporting.pro

2 Uncomment the copy commands in the rate_copy block and modify them as follows:
e Replace SATELLITE_SERVER_1_DATABASE with the satellite server name
e Replace THIS_MACHINE _DATABASE with the central server name

3 Ifthere is more than one satellite server, create and configure new hourly copy commands

for each additional machine.

) Copying polled rate data from each satellite has two consequences.
The amount of traffic between satellite servers and the central
server increases, and the central server’s processing load increases.
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Satellite Server Configuration

Follow these steps to configure a satellite server:

’ Do not follow these steps if you want the satellite server to perform local
reporting, or if the thresholds sub-package is not installed on the satellite
server.

1 Switch off daily aggregations by commenting out the lines referencing
SR_Server_Reporting.pro in the $SDPIPE_HOME/lib/trendtimer.sched file.

2 Modify the SR_Hourly_ Reporting.pro trendtimer entry in the $DPIPE_HOME/1ib/
trendtimer . sched file. By default, this process starts at 40 minutes after the hour. To
make sure the satellite server completes hourly summarizations before the central server
begins hourly summarizations, change the start time from 1:00+40 to 1:00+25.

3 Configure datapipe polling policies, making sure that each system is polled by one
satellite server only.

4 If the satellite server has two or more pollers, create separate polling policies for each
poller and use views and types to separate the devices.

If remote pollers are being used, be sure to avoid duplicate polling across the pollers and
duplicate polling between the satellite and the pollers.

System Clocks

Make sure the system clock on each satellite server is synchronized with the system clock on
the central server.
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6 Thresholds and Change Forms

This chapter covers the following topics:

e Default thresholds set by the thresholds sub-package

¢ Using change forms to:
— Update system properties (including multiple threshold settings)
— Update filesystem properties (including one threshold setting)

Default Settings for Thresholds

The thresholds sub-package imposes a sets of thresholds for systems and filesystems. When
performance reaches a default, OVPI sends a trap to the network management system. The

following tables indicates the threshold and severity level.

Metric Default Threshold Severity
cpuutil_threshold 80% MEDIUM
swaputil_threshold 70% MEDIUM
memutil_threshold 70% MEDIUM
runq_threshold 3 MEDIUM
pageout_threshold 5 MEDIUM
FSutil_threshold 70% MEDIUM

The first 5 threshold values are defined in the K_SR_System. teel file. The last threshold
value is defined in the K_SR_FileSystem.teel file. Every system that is discovered will be
initialized to the default values shown here.

No intervention on your part is required to implement these defaults. Simply install the
thresholds sub-package. If you want to change one or more default settings, use the change
forms described later in this chapter. If you want to modify the action that OVPI takes in
response to an exception condition, configure the Thresholds Module. For details, see the
Thresholds Module 5.0 User Guide.
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Change Forms

The system and filesystem objects maintained for System Resource 4.1 can be modified using
two change forms. These forms do not allow you to create new objects, only to modify existing
objects. The forms are context-sensitive, which means they will modify every object that you
selected before you launched the form. So be sure to use forms carefully. Know in advance
whether you intend to change one object or multiple objects.

’ To create new nodes, locations or customers, or modify existing nodes,
locations, or customers, use the forms in Common Property Tables.

Update System Properties

To launch the Update System Properties form, click the Objects icon in the panel on the left
side of the Management Console window. The Object/Property Management view opens.
Object Manager will present a list of objects. The type of object presented depends on which
Object Manager View is open.

The default view is the Device view, showing a list of devices. The Customer view shows a list
of customers, and the Location view shows a list of locations. To change the view, select View >
Change View and use the pop-up window to select a different view.
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Once the type of object you are interested in updating appears, select the particular object you
would like to update. When you select the object, Update <Object Type> Information will appear
under Object Specific Tasks. Double-click the update task to open Update System Properties,
shown below.

[ /admin/SystemResourceForms fupdate_systen - | Ellil

System Resources [ﬁB

Update System Properties invent

Thiz form allowes system property information to be madified.  Click the OK or
Apply button to save any changes. Click the Cancel button to cancel.

Device HName Lltra

Maximum Processes 1,034.00

Memory Size 655,360.00
Description

Customer Name Customer Unassigned
Location Hame Location Unassigned

System Threshold Limits  The level where exceptions are recorded and
threshald events may be generated.

CPU % 20.00 Runh Queue 3.00
Memaory % 70.00 Page Outs 5.00
Swap % T0.00
K, Apply Zancel

To update system information, type the changes in the fields provided. Note that the customer
name field and the location name field are disabled. The other fields can be modified. To save
your changes, click Apply. When you finish making changes, click OK to save your changes and
close the form.
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Update Filesystem Properties

To update filesystem properties, type the changes in the fields provided. The customer name
field and the location name field are disabled. The other fields can be modified. To save your
changes, click Apply. When you finish making changes, click OK to save your changes and close

the form.

| /admin/SystemResourceForms/update_filesyste - | I:Ilil

System Resources (ﬁfn

Update Filesystem Properties inven:

Device Hame

Mount Point

Remote Mount Point

Last Full Backup

Last Partial Backup

Type

Customer Hame

Location Hame

This form allows filesystern property information to be modified.  Click the Ok ar
Apply button to save any changes. Click the Cancel button to cancel.

Lltra

Qoo aoao oaot 0ao1 0000 ao0a aaoa oaao

0000 00000001 0001 0000 00o0 aooo oo0a

1.36.1.21.253493

Customer Linassigned

Laocation Unassigned

Litilization Threshold %

Filesystem Threshold Limits The level where exceplions are recorded and

threshold events may be generated.

f0.00

(4 Apply Cancel
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7/ Optimizing Resources

Filesystems Resource Optimization brings into focus the most overutilized and the most
underutilized filesystems. Use this report to see where load balancing, as opposed to investing
in additional resources, might be the easiest way to improve service quality.

The selection table at the top of the report provides a list of systems that are expected to reach
90% utilization within 90 days. The grade of service bar chart beneath the selection table
provides a picture of utilization over the last few days, allowing you to track recent increases
and decreases and determine whether a critical situation is getting better or worse. The plot
beneath the grade of service chart tracks daily ups and downs in utilization (CPU, memory,
swap, filesystem, page outs, and run queue length).

Information about underutilized filesystems comes next. This time the selection table
includes filesystems that are expected to be less than 30% utilized within 90 days.

Memory Resource Optimization pinpoints the most overutilized and underutilized system
memory, indicating opportunities where service levels could be improved through better load
balancing. Select a system from the top table to display detailed information for that system.

All aggregation for this report occurs at the daily level. The top selection table lets you see
which systems will have a memory utilization greater than 90% in 90 days. You can also see
an estimate for memory utilization 30, 60 and 90 days from now. The table directly below the
top selection table provides provisioning details for the selected system:

¢ (Customer

¢ Location

e Vendor

e Model

e Operating system

e  Memory utilization threshold

A grade of service stacking bar chart details the overall health of the system, including CPU
utilization, memory utilization, swap utilization and run queue length. A linked, tabbed plot
pinpoints daily CPU utilization, memory utilization, swap utilization, filesystem utilization,
number of page outs, and run queue length for the selected system. The top selection table
and linked drill downs are repeated for systems that are projected to have less than 30%
memory utilization in 90 days.
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System Resource (ﬁﬂ

Filesvstems Resource Optimization invent

The Systemn Resource Filesystems Resource Optimization Report details the maost owver- and underudtilized filesystems, indicating
opportunities for load balancing to improve senvice levels without additional investment. Select a system from the top table to display
detailed infarmation for that system.

Overutilized Filesystems
Projected to Exceed 90% Lkilization within 90 Days

. Current Projected Projected Projected
System Filesystem Wiilization I.Itilizi'itiun 30 Utilizjatiun 60 I.Itilizjatiun a0
Systemd sy a4 52 04 52 Q4 B3 a4 63
Syaten2d ! 04 23 103.90 11147 11844
System fexporthome3 90.62 9245 93.70 94 95
System fexporthomed 89.30 97 .03 1022 107 .40
Systemd Fvar 50,56 151.583 22029 285875
System2a fopt 42.31 111.83 164 06 2624
Filesystem
Yendor Model as Customer Location Litilization
Threshold
Unassigned iES6 Lirwex 2.4 2-2 #1 Sun Apr Custormer Unassigned Location Unassigned 70.0a

Grade of Service (GOS)
System24

Thu Jun 12 2003 - bon Jun 30 2003

CriticalT
Warning | B CPU Lhilization
T Btdemory Ltilization
M dueue Length
GoodT M Swap Utilization

Excellent |

Thu Q000 Sun 00:00 Wed 00:00 Sat00:00 Tue 00 Fri00:00 Mon 00:00
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Filesystem Uiization | cPU Utiization | Memory Utiization | Swap Utiization | No of Page Outs

Filesystem Utilization

SystemZ24: H000012.0
Thu Jun 12 12:00 Ahd - hdon Jun 30 12:00 2

10071 e
anT
E E I:I 4
g ]
2407
207
0 : + + + + +
Fri12:00 Ahd Tue 12:00 Ahf Sat12:00 Al Wed 12:00 Al Sun 12:00 Ak
— Awerage Filesystemn Uszage
Underutilized Filesystems
Projected to be Liilized Less than 30% within 90 Days
current Projected Projected Projected
System File System I Wilization  Wilization  Wilization
LHilization
) 30 1] 90
Systems home 1276 1276 1276 1276 ﬂ
Syatemy fatand 1372 1395 1411 14.27
Syatemny ) 1613 E.30 n.0o n.0o
Syaternd ) 17497 17497 17.4a7 17.4a7
System2s ) 17497 17497 17.4a7 17.4a7
Systermnd fstand 18.53 18.51 18.50 158.449
SystemZy Moot 19.87 19.87 19.87 19.87
g} 2054 19.45 18.64 18.21
Swystemt ChLabel Serial Mumber S5a28b0d 2254 2254 2254 2254
Swsteml3 ChLabel Serial Mumber S5228b0d 2254 2254 2254 2254 ;I
. Filesystem
Vendor Model oS Customer Location
Threshaold
Hewvlett Packard 0005593 HP-UXE.11.11U Customer Unassighed Location Unassighed Fo.aa

Optimizing Resources
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Grade of Service (GOS5)
Systemd

Wed Jun 04 2003 - hon Jun 20 2003

Critical

Wammg“ B CPU Utilization

T Ettemory Lhilization
B Queue Length

M swap Ltilization

GoodT

Wed 00:00  Mon 00:00 Frigd:00 Tue 00:00 Sat00:00 Wed 00:00  Maon 00:00

Filesystem Utilization | CPU Utiization | Memory Utiization | Swap Utiization | No of Page Outs

Filesystem Utilization

Systemnd: 'stand
Wed Jun 04 12:00 A - hon Jun 30 12:00 A

1007
B0t
BOT

Fercent

407
20

Tue 12:00 AM Tue 12:00 AM Tue 12:00 AM
— Awerage Filesystemn Uszage
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Filesystem Utilization | CPU Litiization  Memary Utilization | Sweap Utiization | Mo of Page Outs

Memory Utilization
Systemd

fed Jun 04 2003 - hon Jun 30 2003
v 1o0q
30T
B0t

Percent

401
201

Tue 12:00 AM Tue 12:00 AM Tue 12:00 AM
hemory Liilization

Filesysterm Ltilization | CPU Wiization I Metrory Lhilization I Sweap LHilization Mo of Page Outs

Number of Page Outs

System:d
ied Jun 04 2003 - hon Jun 30 2003

0107
0.081
5]
S 0.067
(‘I}J:I -
o 0.041
'Y} 1

0.021

Tue 12:00 AM Tue 12:00 AM Tue 12:00 AM

Forerage Page Outs per Second

Optimizing Resources
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System Resource

Memorv Resource Ontimization

[

invent

The System Fesource Memary Resource Optimization Report details the most over and underutilized filesystems, indicating
opportunities for load balancing to improve service lewels without additional investment. Select 3 system from the top table to dizsplay

detailed information for that system.

QOverutilized Eystem Memory'
Projected to Exceed 90% Utilization within 90 Days

Current Projected
System Ltilization Utilizlatiun 30
152115172 95.74 101 18
15212515 a9.92 11065
zolcert a2.74 10299
t=hp39.cnd hp.com 79.04 g8.ya
hiatite.chd hp.com 74.05 5964
hpch rose hpcom B5.35 10312
hptciim.cnd hp.com 5336 9515
Vendor Model s Location
Heswlett-Packard Unassigned Location Unazsigned

Grade of Service (GOS)

15.2.115.172
Sun by 15 2003 - Wied by 21 2003

Critical 1

Warning:

GoodT

Excellent:

Sun 00:00

Mon 00:00  Tue 00:00  ‘Wed 00:00

Projected Projected
Hilization 60 Kilization 90

10351 10583 —

13039 13014

12253 14218

5,05 10732

104 .49 119.34

139.06 175.00

140,51 16347 =l

Memory
Customer Litilization
Threshold
Customer Unazsigned 70.00

B CPU Uhilization: 15.70.156.76: Al
OImemory Utilization: 157013676 41

@ ueue Length: 16.70.186.76: Al

O swap Utilization: 15.70.136.76: Al

M CPU Lhilization: tthp 166 .cnd hp.com: Al
OIhdemory Utilization: tthpi6if.cnd hp.com: &l
M Qucue Length: tthplffcnd bp.com: A
O swap Utilization: tthp166.cnd.hp.com: Al
Ocru Utilization: 15.2.114.242: Al

W nemory Utilization: 16.2.114.242: &l

O aueue Length: 15.2.114.242: 4l

W Swap Utilization: 15.2.114.242: Al
OcPu Utilization: 15.2.115.172: Al

B temory Utilization: 15.2.115.172: Al

O aueue Length: 16.2.115.172; Al

@ zwap Utilization: 16.2. 116172 Al

B cPU Lhilization: 15.2.125.15: Al

W hiemory Utilization: 15.2.125 18: Al

O aueue Length: 15.2.125.15: Al
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Grade of Service (GOS)

aaina.india.hp.com
Sun Oct 26 2003 - Tue Oct 28 2003

CriticalT
Warning 1 B CPU Lhilization
T Ehdemory Ltilization
B ueue Length
GoodT M cwap Ltilization
Excellent ]

Mon 12:00 A Tue 12:00 Ak Wied 12:00 A

Metmory Uilization  CPU Utiization | Swwap Wilizstion | Mo of Page Outs |

CPU Utilization

aaina.india.hp.com
Sun Oct 26 2003 - Tue Oct 3% 2003

10071
alT
2 607
2 40t
ED" /
] + + + +
Mon 12:00 Abd Maorn 12:00 P Tue 12:00 Ak Tue 12:00 P
— CPU Uhilization
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B CPU Whilization: 15.70.186 76 Al

Grade of Service (GOS) Otemory Utilization: 15.70.126.76: Al
lovebug.rose.hp.com E oueue Length: 15.70.126 76: A
Sun by 18 2003 - Wied by 21 2003 O zwap Lhilization: 15.70.136.76: Al

M P Lhilization: tthp166.cnd bp.com: Al
Otemory Utilization: tthp 166, cnd hp .com: Al
M Qucue Length: tthp166.cnd hp.com: Al
O swap Utilization: tthp166.cnd.hp.com: Al
O cPU Lhilization: 15.2.114.242: Al

B temory Utilization: 15.2.114.242: Al

O dueus Length: 15.2.114.242: Al

M swap Uilization: 15.2.114.342: Al

O cPU Lhilization: 152115172 Al

B temory Utilization: 15.2.115.172: Al

O oueus Langth: 15.2.115.172: Al

@ swap Utilization: 16.2.115.172: Al

E cPuU Lhilization: 15212515 Al

M tdemory Utilization: 15.2.125.15: Al

O oueus Langth: 15.2.125.15: A

CriticalT

Warning:

Good T

Excellent:

Sun 0000 Mon 0000 Tue 00:00  Wed 00:00

Memory tilization | CPU Utilizstion | Filesystem Utiization | Swap Utilization | Mo of Page Cuts |

Memonry Wtilization
fovefalg. rase i comm
Sun My 12 12:00 A - Wied May 21 12:00 4

307

247

187

1271

E..

|:| t t + + + {
Sun 12:00AM Sun 12:00 PW Man 12:00 A Mon 1200 FM Tue 12:00AM Tue 12:00 FPM Wed 12:00 Al

— Awerage Memony Milization

54
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8 Service Level Management

The Service Level Management - Executive Summary looks at yesterday’s Grade of
Service and yesterday’s exception counts. This report analyzes performance data for multiple
systems, aggregated by customer and location, hence the term summary.

Use the SLM report to verify whether service quality is meeting expectations. The top
selection table provides a list of customers ranked by number of exceptions, highest to lowest.
The data for each customer provides exceptions statistics all of the systems owned by that
customer. The second selection table provides a list of locations ranked by number of
exceptions, highest to lowest. The location selection table is linked to the top selection table,
and separates out the total exceptions for each location.

This report allows you to drill down from information about yesterday’s distribution of
exceptions to a stacked bar chart showing hourly, daily, and monthly views of exceptions and
how they are distributed. The stacked bar chart shows total exceptions for all systems at the
location selected above. At the end of the report, a grade of service chart provides an hourly
assessment of health. This chart is aggregating data from all of the systems at the location
highlighted in the location table.
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System Resource (ﬁﬂ
Executive Service Level Management Summary

invent

The Executive Service Level Management Summary Report provides an owverview of systern peformance. Each chart details key metrics

aggregated for all systems. Key indicators of performance are shown individually and combined into a rade of Service chart to reveal
system health at a glance.

customers
Wed Oct 29 2003
Queue CPU Memonry Swap
Total P Ourt
Customer Hame Evce p:i'ms Length Utilization  Utilization  Utilization E“:g;iuns
Exceptions Exceptions Exceptions Exceptions
All Custotners 24.00 0.0 0.00 24.00 0.0 0.0a
Custamer Unassighed 24.00 0.00 0.0a 24.00 0.00 0.0a
Locations
Wed Oct 29 2003
Queue CPU Memory Swap
location_name E“:;?:ms Length Utilization  Utilization  Utilization Ei:gst::":s
Exceptions  Exceptions Exceptions  Exceptions
All Locations 24.00 0.00 0.0a 24.00 0.00 000
Location Unazsighned 24.00 0.0a 0.0a 24.00 .00 0.ao

Hourly | Daily | Marthiy |

Total Exception Counts

All Systems
Wied Oct 29 2003

M CPU Utilization Exceptions
Otemory Ltilization Exceptions
B 0ueue Length Exceptions

M swap Utilization Exceptions
[JPage Out Exceptions

Total

Wed 06:00 PM Thu12:00AM  Thu 06:00 AM  Thu 12:00 P
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Hourly | Dty | Morthly |

Hourl'y' Grade of Service
All Systems

Wfed Ot 28 2003

Critical

Warning

Good

Excellent

Wed 06:00 P Thu12:00AM  Thu 06:00 AM  Thu 12:00 PM

B CPU Utilization
Otemory Lilization
M duzue Length

W suzp Ltilization

Service Level Management
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9 Resource Forecasting

You have two reports in the resource forecasting area:
¢ Filesystem Forecast
e Memory Forecast

Both reports have very similar formats. The Filesystem Forecast begins with a selection
table that provides a list of all the filesystems that are headed towards 100% utilization and
are expected to reach this level within 90 days. The entries in the table sort by Days to
Threshold (DTT). Filesystems nearest to the threshold sort at the top of the table.

In addition to indicating the value for DTT, the selection table shows:
e Current utilization (the rolling baseline average)
¢ Projected utilization 90 days from today

Select an entry in the table to display the following provisioning details:

e Vendor
e  Model
e O/S

e (Customer
e Location
¢ Filesystem utilization threshold level

From the selection table you may drill down to a daily Grade of Service chart that shows
increases and decreases in a composite score based on individual scores for utilization (CPU,
memory, and swap) and queue length. The series of tabbed line graphs below the GOS chart
track utilization levels and the number of page outs. These graphs track utilization for the
following resources:

¢ Filesystem
e CPU

e Memory

e Swap

The Memory Forecast begins with a selection table that provides a list of all the systems
headed towards 100% utilization and projected to reach this level within the next 90 days. The
entries in the table sort by DDT, lowest number to highest number, or nearest to threshold at
the top, furthest from threshold at the bottom. In addition to indicating DDT, the selection
table shows:

e Current utilization (the rolling baseline average)
e Projected utilization 90 days from today
Select an entry in the table to display the following details for the system:
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Vendor

Model

Operating system
Customer
Location

Memory utilization threshold

From the selection table you may drill down to a daily Grade of Service chart that shows
increases and decreases in an overall score throughout the baseline period. The overall score
is a composite based on individual scores for CPU utilization, memory utilization, swap
utilization, and run queue length.

The tabbed charts below the GOS chart provide daily analysis of trends. These charts show
how the following variables have behaved over the baseline period:

Memory utilization
CPU utilization
Swap utilization

Number of page outs

See below for a sample of the Filesystem Forecast report followed by a sample of the Memory
Forecast report.
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System Resource [ﬁﬂ

Filesvstem Forecast invent

The System Resource Filesystem Forecast report lists all filesystems within 90 days of a otilization threshaold, those closest to a threshold
listed first. The report arms the system managerwith the information required to assess peformance and take prewventive action. Select a

system from the top table to display detailed information for that system.

Estimated Days To Threshold (DTT)
Filesystems Projected to be within 90 Days of 100% UWilization

. oTT Current Projected Projected Projected
System Filesystem WHilization WMilization  UMilization 30 Utilization 60  UHilization 90
dollar india bp.com home 0 90 60 12061 14987 17914
Filesystem
Yendor Model Qs Customer Location Litilization
Threshold
Henwvlett Packard 90005579 HP-UX E.11.00 & Customer Unassigned Location Unassigned yo.o0

Grade of Service (GOS)

dollar.india.hp.com
Tue Oct 28 2003 - Tue Oct 28 2003

Critical T
Warning B CPU Ltilization
T Ehemory Lkilization
M Gueue Langth
Good T W swap Utilization
Excellent |

Tue 01:30 P

Resource Forecasting
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Filesyster Lilization | CRU Utiization | Mermory Ltilization I Swyap Uilization | Mo of Page Cuts

Fercent

1007

401
207

Filesysterm Liilization
dollar.india.hp.com: 4.0
fon Oct 27 01:30 PM - Tue Oct 28 01:30 P

a0t
60T

Man D600 PM Tue 12:00 AM Tue 06:00 AM
—Awerage Filesystemn Usage

Tue 12:00 PM
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System Resource [ﬁB

Memoryv Forecast invent

The System Resource System Memorny Forecast report lists all systems within 90 days of 3 memaony utilization threshold, those closestto a
threshaold listed first. The report arms the system manager with the information required to assess peformance and take preventive action.
Select a system from the top table to display detailed information for that system.

Estimated Days to Threshold (DTT)
Systems Projected to be within 90 Days of 100% Liilization

Sy=tem OTT LHilization Current Liilization Projected WMilization 90
159212515 12.00 a0.32 15674
hiotite.chid hp.con B0.00 7422 113.05
hpch rose hp.com 5700 6535 119.65
tzhp39.chd hp.com F2.00 79.49 135.06
gorilla.cnd hp.com 6.00 S0.83 ES0.40
hptcjjm.chnd hp.com 28.00 2417 194 47
zolcent 53.00 az2.ya 11210
Memory
Vendor Model o5 Location Customer Litilization
Threshold
Sun sundu SUnC= 5.5 Generic_1058525-16 Locstion Unazzsigned Customer Unazsigned .00

Grade Of Service (GOS)

15.2.125.15
Sun by 15 2003 - Thu May 22 2003

Critical T
Warning 1 WM CPU Lkilization
Etiemory Ltilization
M oueue Length
Good T M Swap Ltilization
Excellent

Sun 00:00 Man 00:00 Tue 00:00 Wed 00:00 Thu 00:00
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Memory Liilization | cPU Ltilization | Filesystem Uilization | Swvap Utilization | Mo of Page Outs

Memery Utilization

15.2.125.15
Sun by 18 12:00 A6 - Thu by 22 12:00 Ahd

n + + +
Sun 12:00 Ah ban 1 2:00 Ah Tug 12:00 Ah Wierd 12:00 Ab

Aowverage hMemony Utilization

This 12:00 A
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10 Exception Hot Spots and QuickViews

This chapter covers the following reports:
e Exception Hot Spots
e QuickView

¢ QuickView — Near Real Time

Exception Hot Spots

The Hot Spots report provides a list of the systems that exceeded at least one threshold
condition at some time yesterday. Systems that did not exceed any thresholds will not appear
in this report. This report is particularly useful for identifying systems with the most
exceptions and looking at exceptions in more detail. The selection table indicates which
exceptions took place, and how many of each type took place during the 24-hour period that
ended last night at midnight. Select an entry to display the following data:

e System-level provisioning details (vendor, model, customer, location, and o/s)
¢ Exception thresholds for each resource

Beneath the selection table is a series of charts that track yesterday’s resource utilization
levels on an hour-by-hour basis, allowing you to see exactly when exceptions took place. Near
the bottom of the report you have an Exception Details chart and a Grade of Service chart.
The first chart shows the data that was captured by each poll, throughout the day. The second
chart provides an overall grade of service score for each poll. The overall score is a composite
based on CPU utilization, memory utilization, and queue length.

QuickView

The QuickView has a broader scope than Hot Spots. This report includes every system,
whether or not the system recorded exceptions yesterday. (By default, the selection table is
limited to 50 rows.) The selection table provides utilization averages for yesterday, covering
run queue, CPU, memory, swap, and page outs per second. The default sort order is CPU
utilization. Select an entry in the table to display the following data:

e System-level provisioning details (vendor, model, customer, location, and o/s)
¢ The exception threshold for each resource

The line graphs below the exception threshold information provide hourly data for each
resource, allowing you to track increases and decreases throughout the day.
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QuickView - Near Real Time

The format of the QuickView - Near Real Time is exactly the same as the QuickView:

Selection table that sorts all systems by CPU utilization
System-level provisioning details
Exception thresholds for each resource

Line graphs for each resource

In the QuickView, you are looking at data for yesterday. In the Near Real Time, you are
looking at data for the previous six hours. Use the Near Real Time version of the QuickView
to spot problem areas before the condition begins to affect your users.

QuickView - Near Real Time - Snapshot

The format of the QuickView - Near Real Time - Snapshot is exactly the same as the
QuickView - Near Real Time:

Selection table that sorts entries by CPU utilization over the last six hours
System-level provisioning details
Exception thresholds for each resource

Line graphs for each resource covering the last six hours

In the QuickView - Near Real Time, you are looking at data for the last six hours. In the
Snapshot version of the Near Real Time you are looking at the same data, but only for the
specific systems you specify when you open the report. Use the Snapshot version of the Near
Real Time report whenever you know in advance exactly which system or systems you are
interested in.
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System Resource (ﬁ]g
Hﬂt SpﬂtS invent
The System Resource Hot Spots Report provides a listing of systems that hawve exceeded threshold conditions during the previous day.
Offending systems are ranked by total number of exceptions. Select a system from the top table to display detailed information for that
system.
Probklem Summary for the Day
Systems with Most Exceptions for the Day
Thu hiay 22 2003
Queue CPU Memory Swap
Total P Ot
System Exco pt?uns Length Utilization Utilization Utilization Engsﬁuns
Exception Exceptions Exceptions Exceptions
zolcent a5 0 0 a6 0 0 =
uitra 94 0 11 g3 0 0
152118118 72 24 24 24 0 0
15.70186.76 44 x 0 x 0 0
152114242 24 0 0 24 0 0
15212515 24 0 0 24 0 0
hiotite.cnd hp.com 24 u] u] 24 u] u]
t=hpl §.cnd hpo.com 24 u] u] 24 u] u]
tzhp39 . chd hp.com 24 o o 24 o o LI
Yendor Model Qs Location Customer
Cizco Unassighed Location Unassigned Customer Unassigned
CPU LWilization Memory Litilization Swap Litilization
Run Queue Threshold Pageout Threshold
Threshold Threshold Threshold e 4
50.00 7000 70.00 3.00 5.00
Run Queue CPU Utilization
solcent solcent
Thu by 22 12:00 A - Fri higy 23 12:00 Ahd Thu by 22 12:00 Ahd - Fri higy 23 12:00 Ahd
1007
ant
E EI:I +
g ]
& 407
207 r !
' . Ty )
A12:00 AWM Thu 12:00 P Fri12:00 AM Thu 12:00 Ak Thu 12:00 PM Fri12:00 A
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Memory Utilization

solcent
Thu hday 22 12:00 2 - Fri bday 23 12:00 2

Swap Utilization
solcent
Thu by 22 12:00 A - Thu by 22 12:15 P

100 10071
a0t a0+
§ 1] E‘ B0t
2 401 |
il a 4071
207 T
T 201
0 + { T
Thu 12:00 A Thu12:00 P Fri 12:00 Ahd + +
hemary Utilization Fri11:03 AM Fri11:04 Ah
Page Quts per Second Number of Processes
solcent solcent
Thu by 22 12:00 Al - Thu iy 22 12:15 P Thu by 22 12:00 A - Fri by 23 12:00 A
100T
80T
5 E BOT
=
= F o407
20T
|:| 1 t - 1
} ) Thu 12:00 A Thu1Z:00 P Fri 12:00 Ah
Fri11:03 Ahd Fri11:04 Ahd — Mumber of Processes
Exception Detail | Grade of Service
Exception Details
Time of the CPU Memory  Queue Swap
Exception IHilization Wilization Length Wilization
Thu hfay 22 12:00 20 1.00 8238 0.0o Il
Thu hay 22 1215 oM 0.ys a2.34 n.0o 3
Thu hary 22 12:30 A0 0.50 a2.34 n.0o
Thu by 22 12:45 Ak 1.00 8234 n.0a
Thu by 22 01:00 A0 1.00 g2.34 0.0a
Thu hay 22 01:15 AM 0.ya a2.34 n.0o
Thu hdary 22 01:30 A 1.00 8235 n.0o
Thu by 22 01:45 AM 0.ya g2.33 n.0o
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Exception Detail  Grade of Service

Grade of Service (GOS)

solcent
Thu bty 22 1300 8hd - Fri by 23 12:00 2hd

Critical
. B CFU Utilization
Warnin
e Etiemony Utilization
H queue Length
Gaaod

g 1

Thu 00:00 Thu 0315 Thu 06:45 Thu 10:00 Thu 12:30 Thu 16:45 Thu 20:158 Thu 23:30

Exception Hot Spots and QuickViews
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System Resource (ﬁ/n

Quickview invent

The System Resource QuickVWiew Report gives the system management staff a detailed look at the peformance of individual systems.
Select a systemn from the top chart to display detailed information for that system.

Cuickview Selection

Thu May 22 2003
Average Average Average Humber of
System .H.ut:;:gﬁ:un CPU Memory Swap Page Quts g:l;:::;:;
] ] Liilization Liilization Litilization Per Second
lovehug rose hp.com 0135 10.43 2275 g.00 .00 1.674.00 :I
tthp1 66 .cnd hp oo 1.82 904 a7 46 £1.00 0.00 3,289.00 —l
157018676 377 6.549 94 46 2610 0.20 1.974.00 ;I
Vendor Model 0% Location Customer
Hemwvlett-Packard Unassigned Location Unassigned Customer Unassigned
CPU Lkilization Memaory Litilization Swap Lhilization
Run Queue Threshold Threshold Threshold Threshold Pageout Threshold
3.00 G0.00 70.00 70.00 5.00
Run Queue CPU Utilization
15.70.186.76 156.70.186.76
ied himy 21 12:00 Ahd ied hiay 21 12:00 2hd
BT 1007
5T a0t
4T = 1
— EI:I 4
2T o 1
1T 207
0+ + | 0 + |
Wad 12:00 Ak Wad 12:00 P Thu 12:00 A Wed 12:00 Al Wed 12:00 P Thu 12:00 Ak
Tirmne of Day Tirne of Day
— Awrerage Fun Queue — forerage CPU Lkilization
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Memory Utilization

15.70.186.76
Wied by 21 12:00 2hd

“IEIEII
EEI:
60T
4EI:
a0t

Fercent

Wed 12:00 PM Thu 12:00 AN
Tirne of Day

Forerage hemory Utilization

1]
Wed 12:00 Ahd

Number of Page Outs

15.70.186.76
Wied hiay 21 12:00 Ahd

Total

Wied 1200 PM Thu 12:00 AM
Titme of Day

Pyerage Page Outs per Second

Wed 12:00 Akt

Swap Utilization

15.70.186.76
Wied higy 21 12:00 2hd

1007
anT
= 1
@ EI:I__
N 4D:
20t
0 + 1
Wed 12:00 A YWied 12:00 PM Thu 12:00 AM
Tirme of Day
— Ffwrerage Swap LHilization
Number of Processes
15.70.186.76
Wiied iy 21 12:00 A
G901
T2t
E 54:
=367
181
|:| + |
Wied 12:00 A Wigd 12:00 PM Thu 12:00 Am
Tirme of Day

— Total Awerage Mumber Processes

Exception Hot Spots and QuickViews
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Quickview - Near Real Time

inwvent

The Systemn Resource Mear Real Time QuickView gives the system management staff an up to date view of the pedformance of individual
systemns. By selecting a system from the top table, current system pedformance (up to the most recent data collection) can be inwestigated
in detail.

System Selection List
Select Systemn to See Hear Real Time Information

Total Average
Total Run Total CPU Total Swap Humber of
ystem Queue Litilization M_Efmn_w LHilization Page Outs Processes
LHilization per Second
152118115 2932 959,99 9514 5453 0.00 155.00 ﬂ
tthpd 0.chd bp.com 1.25 1616 &9.59 20.00 0.00 12820
gorilla.chd hp.com 545 13.90 Gd 65 Z2.00 0.00 155 60
tzhp39.cnd hp.com 0.3y 12.35 &1 .60 £1.00 0.00 451.00
Hthp2S.chd hp.com 016 12.00 .5 7.00 0.00 12200 ;I
Yendor Model Qis Location Customer
Hewvlett-Packard Unassigned Location Unassigned Customer Unassigned
CPU Liilization Memaory Litilization Swap Ltilization
Run Queue Threshold Threshold Threshold Threshold Pageout Threshald
3.00 a0.00 Jo.00 Jo.00 5.00
Run Queue CPU Utilization
15.2.118.118 15.2.118.118
Fri bty 233 05:00 Ahd Fri gy 23 0500 A
10071 100
alt IRy
! !
207 207
] |:| - $ - { ] |:| - t - {
Fri 05:00 Ahd Fri O7:00 Ahd Fri 09:00 Abd Fri 05:00 Ahd Fri O7:00 Ahd Fri 09:00 Abd
— Total Run Queue — CPU Lhilization
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Memory Utilization

15.2.118.118
Fri bty 23 0800 Ahd

1007
IR
E El:l"
!
& 407
207
0 t |
Fri05:00 AR Fri 07:00 Al Fri 09:00 Ah
hdemary Litilization
Number of Fage Outs
15.2.118.118
Fri higy 23 05:00 Ahd
:
=
} : 1
Fri 05:00 AR Fri O7:00 Am Fri 09:00 Ah

Forerage Page Quts per Second

Exception Hot Spots and QuickViews

Swap Utilization

15.2.118.118
Fri bty 23 0800 Ahd

1007
IR
E EI:I"
T
& 407
207
0 t |
Fri05:00 AR Fri 07:00 Al Fri 09:00 Ah
= Tuatal Swap Lkilization
Number of Processes
15.2.118.118
Fri higy 23 05:00 Ahd
2001
1607
E 12EI:
= ant
407
0 t |
Fri 05:00 AR Fri O7:00 A Fri 09:00 A

— Mumber Of Processes
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System Resource [ﬁB

Snapshot - Near Real Time

invent

The System Resource Mear Real Time Snapshot Report gives the system management staff an up to date view of the pedformance of

individual systems. By selecting a system from the top table, current system peformance (up to the most recent data collection) can be
inwestigated in detail.

System Selection List
Select Systemn to See Hear Real Time Information

TotalRun  Total CPU  Total Swap MT'““' PA"'Er;f_': Humber of
yelem Queue LHilization Litilization EI‘I‘ID-F_',F age s Processes
Liilization per Second
152118118 2832 9999 o4 53 9314 .00 188.00 ﬂ
tthi O.chd hpocom 1.28 1616 20.00 8989 .00 128.20
goarilla.chd hp.com 245 13.80 22.00 54 65 .00 188.60
tzhp39.chd hp.com 037 1235 &1.00 &1 .60 .00 461.00
thp25.chd bipcom 016 1200 7.00 31495 0.00 12200 j
Vendor Model 05 Location Customer
Herwlett-Packard Unassigned Location Unassigned Custormer Unassigned
CPU Liilization Memaory Litilization Swap Lilization
Run Queue Threshold Pageout Threshold
Q Threshold Threshold Threshold 4
3.00 a0.00 F0.a0 Fo.ao 5.00
Run Queue CPU Utilization
15.2.118.118 15.2.118.118
Fri by 23 05:00 £ Fri by 23 06:00 &
1007 100
gt aoT
= BOT T EOT
2 ] 2]
£ 407 £ 407
2071 2071
0 ! — 0 ! —
Fri 05:00 A Fri07:00 AM Fri 09:00 AM Fri 05:00 A Fri 07:00 AM Fri 09:00 AM
— Taotal Run Queus — CPU Lkilization
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Memory Utilization Swap Utilization

15.2.118.118 15.2.118.118
Fri hayw 23 05:00 2 Fri hayw 23 05:00 2
1007 1007
g0 g0
= G0T T GOt
! T
d 407 d 407
207 207
0 + | 0 + |
Fri05:00 A Fri O7:00 A Fri 09:00 A Fri05:00 A Fri O7:00 A Fri 09:00 A
hemory Litilization — Tatal Swap Lkilization
Number of PEQE Outs Number of Procaesseas
15.2.118.118 15.2.118.118
Fri hday 23 05:00 2hd Fri hday 23 05:00 2hd
20071
1607
" — 1201
E 2
|_ ED..
a0t
} : | 1] + |
Fri05:00 AR Fri O7:00 Am Fri 09:00 Am Fri05:00 AR Fri O7:00 Ahk Fri 09:00 Am
Forerage Page Outs per Second — Mumber Of Proceszes
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11 Top Ten Reports

System Resource 4.1 contains two Top Ten reports:
e Top Ten (Exception Volume, CPU Utilization, Filesystem Utilization)
e Top Ten Transactions

Both reports perform a ranking function. The first one contains three tables and no graphs or
charts. This report brings into focus yesterday’s exception volume, yesterday’s CPU
utilization, and yesterday’s filesystem utilization. Use this report to spot systems with high
exception volume, systems with high CPU utilization, and systems with high filesystem
utilization.

In addition to ranking systems, each table in this report provides the following provisioning
details:

e Customer

¢ Location

e Make

e  Model

e Operating system

The systems that appear in this report may not be exceeding thresholds and generating
exceptions. The volume and utilization levels that appear in this report may be over threshold
levels, or they may be well under threshold levels. If you are interested in knowing which
systems are producing the most exceptions, use the Hot Spots report.
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TDDTE“ invent

The System Resource Top Ten Report lists up to ten top wvolume contributors and ten systems exhibiting the poarest health forthe day.
Servers with the largest change in wolume ar health from the previous day are also listed, indicating unstable conditions that warrant
further investigation. Select a system from the top chart to display detailed infarmation for that system.

Systems with Highest Yolume

Tue Oct 28 2003
Average Average
Total Total Colligion .

System InPackets outPackets Rate per Error R;?te Customer Locatio

. per min

min

survadindiahpootm 2255185000 2255920200 2267 Custatmer Unassighed Location Una:
aaing indis hp.com 6,442 713.00 q018,745.00 42595 Customer Unassigned Location Una:
dollar indis hp.com 1,131,713.00 95 315,00 177 Customer Unassigned Location Una:

Systems with Highest CPU Utilization

Tue Oct 28 2003
Average  Average
System CPU Queue Customer Location Make Moc
IHilization  Length
aaing indis hp.cam 3835 0.30 Customer Unassigned Location Unassighed Heswlett Packard 9000
zUrya indis hp.com 17.79 0.2s Customer Unassigned Location Unassighed Heswvlett Packard 9000
dollar indis hp.cam Q.73 0.33 Customer Unasszigned Location Unassigned Heswlett Packard 9000
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System

dollar indis.hp.com
dollar india.hp.com
sy india.hp .com
dollar indis.hp.cotn
suUrya india.hp .com
dollar indis hp.com
sUrya india.hp .com
=uUrya india.hp .com
dollar indis hp.com

Rl

Systems with Highest Filesystem Utilization

Average
Filesystem
Ltilization
90.53
5752
8177
51.00
44 22
43352
4230
3154
2358

Tue Oct 28 2003

Filesystem Customer
home Customer Unazsigned
! Customer Unazsigned
It swwap device Cuztomer Unazzigned
ClearCaze Cuztomer Unazzigned
ClearCazelvobs? Customer Unassigned
Amp Customer Unassigned
! Customer Unassigned
fatand Customer Unassigned
fatand Customer Unassigned

Location

Location Unassigned
Location Unassigned
Location Unassigned
Location Unassigned
Location Unassighed
Location Unassighed
Location Unassigned
Location Unassigred
Location Unassigred

Make

Heswdlett Pack:
Heswdlett Pack:
Heswdlett Pack:
Heswdlett Pack:
Heswdett Pack:
Heswdett Pack:
Heswdett Pack:
Heswdett Pack:
Heswdett Pack:

i

Top Ten Reports
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A Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate,
you can easily change to a different view. If you are using Report Viewer, right-click the object
to open a list of view options. If you are using the Web Access Server, follow these steps to
change the default view of a table or graph:

1  Click Preferences on the links bar.

Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click the Edit icon next to the table or graph.

o O AW N

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.

Sek Time Period, ..
Change Constraint Yalues...

Select Modes/Interfaces, ..

Change Max FRows. .,
Ve in e Franme

Print Table. ..

Export Element as C3Y...
Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.
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Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

ies Table ¥iewer

Polled IP QoS Statistics Data - Input

Cver Previous 6 Hours

IpPrecedence Switched Bytes
u] 105,688

o o o o0

GO0

02,234

O L o e L. | B (O T % B
]

Lo B R |

View Options for Graphs

Switched Plis

GYa

o th OO O O O

G622

L I Y o

=10l

Time Period
Tue Ot 29 0700 A
Tue Ot 29 0700 Ahd
Tue Oct 20 07:00 Ahd
Tue Ot 29 0700 A
Tue Oct29 0700 Ahd
Tue Oct 20 07:00 Ahd
Tue Oct 29 0700 A
Tue Oct 29 0700 Ah
Tue Ot 29 0645 Ahd
Tue Oct 29 0645 Al
Tue Ot 29 05495 A
Tue Ot 20 06495 Ahd
Tue Oct 29 0645 Al

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

40000 1

22720 7

29540 1

163 60 1

2180 1

0

Sap 17 Sep 21 Sap 25 Sep 28

add Cverlay. .
Remave Overlay

Set Time Period. .,

hange Constraint Yalues. ..

Select Modes)Interfaces, ..

Displayed Data

Grid
Legend
Skyle

. . .

—hange Max Rows. ..

Display Daka Table

Export Element as CSW. ..
Display: Gverlay Data Table
Excport Graph @verlay Data as C54

View in new Frame

Print Graph. ..

Delete Graph
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The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines

Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

Set Time Period. .. 43 s
Change Constraint Yalues. ..

Select Modes)Interfaces. ..

Displayed Data [ % !

Grid k

Legend J /\

Shyle Area

Change Max Rows. .. Stacking Area

Display Dakta Table Bar

Export Element as CSY... Stacking Bar

Display Gwerlay Data Table Pie

Export Graph Overlay Data as C5.., # Flot

Yiew in new Frame Scatter Plot

Prink Sraph. .. AL B S
e B Hi-Lo-Cpen-Close —

—roa  Candle

Editing Tables and Graphs 83
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

T+

95 Ee0

olure

7170 ¢

Sat Feb 24 06:00 &M EST
Mormal Disconnect (107 j= 74.00

s

04 t L t + t t t t
04:00 0E:00 0300 10:00 12:00 1400 16:00 1800 20:00 2200

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected

time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

% 200,00

180.00
120.00
20.00

40.00

Mon 01 Tue 02 iad 02

Ml 2:0q Utilization (H)
I td a3 Utilization (H)
B Ut Threshold
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

14,924.00 -
9,539 .20
7,154.40

4,769 50

Forecast Minutes

2,364 80

Tho 01 Fri 0Z Sat 03 Sun 04 hon 05 Tue 06 ied OF
D=ys Of The Wieek

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows

in units of ten.

200.00
160.00
120.00

20.00

40.00

u]
bon 041 Tue 02 ed O3

M =g Utilization (H)
I 1 ax Utilization ¢H)
M Uil Threshald
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.

7850 1

6280 1 ﬂ
o)
av0 [E M K

3140 1
16.70 1
u} + t
Mon 01 Tue 02 Wed 03
— fuwrg WMilization (H)
— hax Utilization (H)
— Wtil Threshold
Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

W Under 1 minute

O between 1 and 5 minutes

O petween 5 and 30 minutes

O Betwesn 30 minutes and 2 hours
B Between 2 hours and 12 hours
M Cver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.
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Display Data Table

This option changes a graph into a spreadsheet.

=1k
* Axis I Average I

Tue Feb 19... 0.509

Tue Feb 19... 0.621

Tue Feb 19... 1.026

Tue Feb 19... 0.362

Tue Feb 19... 1.171

Tue Feb 19... 1.051

Tue Feb 19... 0,254

Tue Feb 19... 0.526

Tue Feb 19... 1,433 %

Tue Feb 19... 0.967

Tue Feb 19... 1.471

Tue Feb 19... 1.308

Tue Feb 19... 1.123

Tue Feb 19... n.93

Tue Feb 19... 1.497

Tue Feb 19... 0.506

Tue Feb 19... 0.725

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

=10l x|

Hetwork Response Time
Cizco_04
Tue Feb 19 12:00 &M - Tue Feb 19 11:00 P

Seconds

Tue 05:00 AM Tue 11:00 PM
— fwerage

Editing Tables and Graphs
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Index

A group_manager, 30
Add Database Wizard, 40 group filters, 11
adding customized property data, 12
ad hoc selector reports, 7 H
Host Resources MIB, 15
C HP OpenView Performance Agent, 16

change max rows option, 83

|
integration with NNM, 11

collection_manager, 30
configuring distributed systems, 34, 43
customized data table views, 30, 32 K

custom views of data or property tables, 30 K_padatasources table, 15

D
Datapipe Manager, 30

L
Launch Point, 7

demo package, 12 legend options, 83

device aggregations, 41

Display Data Table, 83 (0]
displayed data option, 83 options for viewing reports, 32
distributed systems, 29
P
E pa_discovery.data file, 15
extracting packages from the report pack CD, 35 polling policies, 29, 32
: prerequisites for SR 4.0, 30
Product Manuals Search (web page), 13
forms
Update Filesystem Properties, 46 R
Update System Properties, 44
remote pollers, 29
G report linking, 7
generic reports report parameters, 12
executive summary, 10
forecast, 10 S

hot spots, 10

near real time, 10
quickview, 10 SNMP discovery, 15

top ten, 10 SR_Hourly_Reporting.pro, 40, 41
grid options, 83 SR_Server_Reporting.pro, 41

satellite servers, 41, 43



style options for graphs, 83
SysRes OVPA Collection Datapipe, 15

T

trendcopy pull commands, 40

U

upgrade packages, 8
upgrading SR 3.0 to SR 4.0, 30
Use Absolute Time, 81

\'}

version history, 8

view in new frame, 82
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